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Congratulations on your new Gripping Force Tester GFT®-X 270! You have made an excellent
choice in buying this innovative technology which offers a variety of advantages in its use. In
order to avoid handling errors you should take a few minutes and read these operating manual
carefully.

When you have read these manual you should keep them safely at a place where they can be
easily accessed so you can refer to them again at any time. Keep your Gripping Force Tester
GFT®-X 270 in the transport case where it has optimum protection. When the device is
dispatched for maintenance or repair, it must also be sent in the transport case so that the
sensitive parts are protected in an optimum way during transportation.

The information and data contained in these operating manual may be modified without prior
notice. No part of this documentation may be reproduced or transmitted for any purpose
whatsoever, regardless of the mode or the means, electronically or mechanically, without the
prior permission in writing of MESA Systemtechnik GmbH.

In order to protect the unit against fire, electric shock or potential destruction of the electronic
components, it must never be exposed to rain or extreme humidity. Direct sun or heat are to be
avoided as well.

Please do not try to open the hand-held unit or the measuring device. There are no parts inside
which you could maintain.

All data in this publication have been compiled and checked with utmost diligence, nevertheless
errors and mistakes cannot be totally excluded.

All modifications, in particular those relating to technological improvements, are reserved.

© 2012 + MESA Systemtechnik GmbH ¢+ Konstanz ¢ All rights reserved.

H.-D. SCHUNK GMBH & CO. SPANNTECHNIK KG Lothringer StraRe 23 D-88512 Mengen
Tel. +49-(0)-7572-7614-0 Fax +49-(0)-7572-7614-99 www.schunk.de
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1 Introduction

This manual contains important information about connection and safety operation of the
Gripping Force Testers GFT®-X270. Please read the safety instruction carefully.

2 Safety information

2.1 Introduction

The Gripping Force Tester GFT®-X 270 is constructed according to DIN EN 61010-1; VDE
0411-1:2009-06. At the upper front face the Handheld Unit contains an USB slave connector for
data communication with a Windows® based computer and for power supply / recharging. The
Power Supply Plug operates in the range of 100V~-240V~ alternating current and complies with
EN60950-1 and UL60950-1.

2.2 Safety information pictograms

Helpfull Information / Hints
9 Pictogram advices helpfull informations and hints.

%‘ Danger!

Please read observantly, non-compliance may result in risk of severe damage to
@ your health.

Warning!
A Non-compliance may result in risk of damage at the GFT-X.

3 System requirements
Operating Systems

Windows 2000
Windows XP
Windows Server 2003
Windows Vista
Windows 7

Recommended Hardware

e 233 MHz processor (Recommended: pentium 500 MHz or newer processor)
e 64 MB RAM (Recommended: 128 MB RAM or more)
20 MB of hard drive space

H.-D. SCHUNK GMBH & CO. SPANNTECHNIK KG Lothringer StraRe 23 D-88512 Mengen
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4 Introduction

The Gripping Force Tester GFT®-X 270 allows the measurement of tension when the chuck or
collet is in either static or dynamic mode.

Using a complex array of strain gauges in the Measuring Head, the mechanical forces are
converted into an electrical signal and amplified by the integrated electronics. The amplified
signals are transmitted from the Measuring Head with an integrated UHF transmitter (433MHz)
to the Handheld Unit to be displayed and processed.

On the display the current clamping force and, in dynamic mode, the accompanying number of
revolutions of the chuck are indicated.

The Handheld Unit is equipped with a high resolution TFT display which shows all important
menu items as icons. These icons, which are self-evidend, and a transparent command
structure allows easy operation also for occasional users.

All items are designated for use in severe workshops, the Handheld Unit is in addition equipped
with a silicon protector and offers therefore utmost protection against shocks and drop down.

4.1 Packing list

When you open the case, please make sure that all parts and components are included in the
Gripping Force Testers GFT®-X 270 M3 / M4 package:

Handheld Unit GFT®-X 270 with Protector

Power Supply Plug with USB master-connector

Adapter for North America, United Kingdom, Australia and Europe

GFT®-X ChuckExplorer for Windows-XP / Windows 7

(CD contains operating software and operating manual)

USB- connecting cable from Handheld Unit to PC/Laptop, approximately 1m length
Measuring Head for jaw chucks with rotating electronics and 4 each of Extension
Cylinder for jaw diameter g72mm

3 each Extension Cylinders for jaw diameter >88 und >108mm

Torx-key T15 inclusive spare screws

Stand with magnetic mounting for rpm measurement

Measuring Head - charging cable, 2 pin, approximately 1m length

Loading Bracket for Measuring Head

NEERRA HH RRREF

The GFT®-X Upgrade Kit includes following parts:

Handheld Unit GFT®-X with Protector

Power Supply Plug with USB master-connector

Adapter for North America, United Kingdom, Australia and Europe

GFT®-X ChuckExplorer for Windows-XP / Windows 7

(CD contains operating software and operating manual)

USB-connection cable from Handheld Unit to PC/Laptop, approximately 1m length

™

N M

Inifo GFT®-X Upgrade Kit can only be used for Measuring Heads showing a serial
number of >= 0089-3.

For other Measuring Heads packing list can vary.
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5 Overview

Steckernetzteil
100V-240V~

Ladekabel
Messkopf

LU L LY

Messkopf M1 Messkopf M2
Handgerat

GFT-X 270

Messkopf M3 / M4
Figure: GFT®-X measuring set up
A fundamental distinction is made between stationary and dynamic mode:

i | Static operation

Info

e needed

—— Dynamic operation

8.3.2)

Measuring Head to be clamped, magnetic mounting for rpm measurement is not

Infe Measuring Head to be clamped, the stand for rpm measuring is fastened to the
Q support of the machine. Now the support must be positioned in such a way that the
magnetic bar ends besides the black cover of the Measuring Head (see chapter
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6 Technical Data

6.1 GFT®-X Handheld Unit

Power supply via USB, 5V DC

Measurement range / gripping force F

indication in kN or Ibf, selectable by user
bargraph in % full scale, wheras value of
measurement range is indicated as follows:
0.....80% green,
80....95% yellow,
95...100% red.

Measurement range / speed (rpm)

indication in 1/min (can be switched off)

Dimensions 220x100x50mm
Weight 4609

Operating temperature 0...40°C
Protection class IP54

Interface PC / Laptop USB 2.0

Data cable/charging cable Handheld Unit

approx. 1,5m length

Charging cable for Measuring Heads

approx. 1m length including mating connector

Receiving frequency

433,92 MHz

Distance Handheld Unit / Measuring Head

see chapter 6.2 /6.3

6.2

Measuring Heads for collets

Measuring Head M1

Measuring Head M2

Power supply

internal energy storage

Energy storage capacity

ca. 1,5h@50% duty cycle

Measurement range/gripping

force E 0...75kN

0...120kN

Measurement range/
speed of rotation (rpm)

>approx. 200* to <10.000 rpm

>approx. 200* to <8.000 rpm

Accuracy (F/rpm) <5% / <1% fsr
Clamping diameter 18mm 42mm
Number of jaws 3 3

Dimensions 918/57x56mm 942/57x63mm
Weight 4009 7009
Operating temperature 0...40°C

Protection class IP65

Transmitting frequency 433,92MHz

Charge time <3 minutes

Distance Handheld Unit/
Measuring Head

>1m and <4m straight line (value may vary depending on the
ambient conditions)

*) the lower value can start from 60 rpm by reducing the gap between magnet and Measuring

Head from 3mm to about 2mm

H.-D. SCHUNK GMBH & CO. SPANNTECHNIK KG Lothringer StraRe 23 D-88512 Mengen
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6.3 Measuring Heads for jaw chucks
Measuring Head M3 Measuring Head M4
Power supply by internal energy storage
Energy storage capacity approx. 1,5h@50% d.c. approx. 1,5h@50% d.c.
Measurement range/gripping 0...180kN (2 jaws) 0...30kN (2 jaws)
force F 0...270kN (3 jaws) 0...45kN (3 jaws)
Measurement range/speed (rpm) >ca. 200* bis <6.000 rpm
Accuracy (F/rpm) <3% / <1% fsr <1,5% / <1% fsr
Clamping diameter 72...108mm
Number of jaws 2 or 3, user adjustable
Dimensions 268/57x63mm
Weight 700g without extentions
Operating temperature 0...40°C
Protection class IP65
Transmitting frequency 433,92MHz
Charge time <3 minutes
Distance Handheld Unit/ >1m and <4m straight line (value may vary depending on the
Measuring Head ambient conditions)

*) the lower value can start from 60 rpm by reducing the gap between magnet and Measuring
Head from 3mm to about 2mm

6.4 Mains / Battery operation

The GFT®-X Handheld Unit is supplied by 5VDC (500mA) via a Power Supply Plug with an input
voltage range from 100VAC to 240VAC. Different interchangeable blade assemblies for North
America, United Kingdom, Australia and Europe are included.

Please see chapter 13 for a guidance to exchange the interchangeable blade assemblies.

Furthermore GFT-X is equipped with a powerful battery (Li-lon). A one time charge allows an
operation up to 5 hours. During this time frame, a Measuring Head can be loaded up to 4 times
out of the Handheld Unit battery.

A correct indication of the charge condition is only possible until the battery is

Info completely full charged and discharged first. It's recommended to charge the

9 handheld unit first completely and then use it until the power is turned off
automatically.

Charging condition of the battery is indicated on battery symbol in Status Line, left side (see
chapter 7.3).

Infle Battery could, if not in use and not charged for several months, discharge itself.
If operating time drops down to less than 2 hours it is recommended to replace the
e battery (see chapter 15)
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7 Handheld GFT®-X

7.1 Overview

Measuring Head  USB interface/
Power Jack Power Plug

<+————Status Line

<+«—Set Menu

Command Line
/

<«— Display Line for Speed Buttons / Softkeys

Speed Buttons
LED indicator

Key Pad
GFT-X 270
Sﬂllﬁ(
e Powerswitch
7.2 Keyboard GFT®-X Handheld Unit

To switch on and off the Handheld Unit press

for about 2 seconds. First it appears the

Welcome Logo, at the same time blue LED twinkles. The Set Menu appears after 2 seconds

automatically.

Al|A| |A| A

A

ANR
<@
G

<J@3r

GFT-X 270

a

Speed Button — With this button the above indicated menu
item will be chosen. These buttons are freely configurable

(see chapter 7.4)

Moves icon or line above @ Moves icon or line down

I:b Moves icon or character / number to the right

<l:| Moves icon or character / number to the left

l V Delete deletes last input (character / number)

% Menu Back to Main Menu

é ESC  Back one level above

n OK Confirm selection

H.-D. SCHUNK GMBH & CO. SPANNTECHNIK KG Lothringer StraRe 23 D-88512 Mengen
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7.3 Status Line

= & S0 & E

Explanation of the symbols from left to right:

= (= (= | |-

>80% >50% >10% <10% <10%, <10min (charging condition/remaining time)
Indicates the current charging condition of the integrated Lithium-lon battery. At a remaining
operating time of less than 10 minutes a pop-up window appears and remembers you to
connect the Handheld Unit to a Power Supply or a PC.
If the charging symbol turns red it is not possible charging the Measuring Head or the charging
process stops.

1

e
e,
53 |5 15

J

[ |

If an unloaded Measuring Head shows >0kN (offset), tare is possible by pressing I:b in the
menu Measurement.

Deviations >3% (M1 — M3) and >5% (M4) of measurement range couldn’t be compensated.
The Measuring Head should be returned for service.

Meaning of symbol colors:

Green symbol - Measuring Head works fine, no tare applied

Yellow symbol - Measuring Head still works fine, however tare has been applied

Red symbol - Measuring Head for service, offset to large, tare is impossible

<| |*<=

Green symbol if PC or Power Supply is attached and connection is fine. Red symbol means no
USB connection.

@ @

Blinking green symbol indicates proper radio communication to Measuring Head.
Red symbol indicates disturbed radio communication or no Measuring Head available /in range.

3 & (8 @ @ D

Indicates chosen Measuring Head M1 or M2. At M3 and M4 the number of jaws is also
indicated.

H.-D. SCHUNK GMBH & CO. SPANNTECHNIK KG Lothringer StraRe 23 D-88512 Mengen
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CRENRERL

Charging condition of Measuring Head, quantitative indication only (shown if measuring head is
switched on).

Amwtﬂ@ﬂ Tara function always to refers to the dedicated Handheld Unit. If Measuring Head is
ﬁ tared with different Handheld Units the Measuring Head could be damaged.

Infle The charging condition detection of Handheld Unit is self-learning. It takes several
charging cycles till the charge status is detected properly. First charge is already
made at factory.

7.4 LED indicator

Left and right below the Speed Buttons two LED are located with following meaning:

A A A A - While pressing w twinkles some times prior to

Welcome Logo appears

o - twinkles as soon display turns into Power Save Mode
O\ (display almost dark)
— Charge indicator: LED is illuminated during charging is in
progress

The lowermost line of the display is reserved for Softkeys
which can be programmed by the user. The left three Icons
are free to be programmed, whereas the Icon on the right
side is predetermined to charge the Measuring Head.

Setting / programming Speed Buttons

-choose the relevant function

-activate the Icon (triangle on the left and a highlighted
frame)

-press desired Speed Button for about 2 seconds

-the Icon appears in the display

As soon as desired symbol appears in the Speed Button
Bar, the programming is finished successfuly.

The Softkeys could be programmed as often as desired.

Info Already programmed keys couldn’t be deleted. Only overwriting is possible.

Q In some Menus not each Softkey is available.

H.-D. SCHUNK GMBH & CO. SPANNTECHNIK KG Lothringer StraRe 23 D-88512 Mengen
Tel. +49-(0)-7572-7614-0 Fax +49-(0)-7572-7614-99 www.schunk.de



Gripping Force Tester GFT®-X 270 Rev. 1.8/1.5 12/2012 page 13

7.6 Menu GFT®-X Hand Held - outline

Use the arrow keys for easy navigation on Set menu. By pressing nyou will end up directly to
the important sub menu.

The chosen or activated Icon will be discovered by a triangle on the left side and a highlighted
frame. A clear explanation is also shown in the Command Line.

The main menu encloses represented icons:

Icon*) Description Further notes

Measurement see chapter 7.6.2

Define new data collection see chapter 7.6.3

Settings see chapter 7.6.4

(ﬁ Menu Measuring Head see chapter 7.6.5
i

Menu collet chuck see chapter 7.6.6

R /] Select language see chapter 7.6.7
Tl

*) All Icons figured as ,selected”, identifiable by the white triangle, at the left side of the border.

Infe All functions and Icons are explained in a tree structure on next page, followed by a
detailed description of the relevant commands.

H.-D. SCHUNK GMBH & CO. SPANNTECHNIK KG Lothringer StraRe 23 D-88512 Mengen
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7.6.2 Measuring

Individual measurement for an experimental setup could easily be performed and
displayed with this function. The Measuring Head to be chosen should be desired
and activated under Icon Menu Measuring Head.

Info If a pop up Windows appears with ,No Measuring Head connected!* make sure that
9 Measuring Head is switched on (white LED on Measuring Heads front face is
twinkling). Radio communication should also be checked.

7.6.2.1 Measuring Head Recalibration
If the Measuring Head is connected to GFT®-X Handheld

Unit, following message will be shown:

Serial number: X X X X — X

aYaYa) Calibration expires:

When using a new Measuring Head it will give an advice

Serial number: (see date code) to a label sticked on the Measuring Head.

ORZRORTE=N3 The sticker shows the date when factory calibration date
Calibration expires: expires.

02_2011 After the first factory recalibration the date of expire will be

shown in a format MM_YYYY like shown in the sample left.

Version: Recalibration should be performed at least every 12

2 -1 months to guarantee correct function of Measurement

ok | Head.

Version: y_y displays software version of Measuring Head

To be confirmed by pressing OK

— The Handheld Unit now shows the current measurement
values. If no load is applied to the Measurement Head and
the indication shows a value >0kN, tare function can be
applied by pressing [=> (see chapter 7.3).

080,4 kN Depending on individual Setting (see chapter 7.6.4) the

force only will be indicated or both force and speed. The

»)))))))o))))))))’) i(r)ué Oflcijrf;‘.orce can be adjusted to kN or Ibf (1kN = 0,2248 x

100
If needed the Measuring Head can be recharged directly

0 6 0 7 . form this menu by using the relevant Speed Button.
1/min

If no Measuring Head is chosen the message No
1000 ( Measuring Head connected! appears. This window must
Ibf be confirmed by pressing OK. Managing all Measurement
Heads must be performed under Menu Measuring Head,
chapter 7.6.5.

-
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7.6.2.2 Recharge Measuring Head

This Icon is available independent where you currently are. It allows easy and fast loading of a
linked Measurement Head at any time. Just link the Handheld Unit to the
Measurement Head (switched off) with the Connecting Cable and press the relevant

o Speed Button. The message “Measuring head battery charging...” appears. Is the
loading process finished after a few minutes the message “Battery is fully charged”
appears. Both popup windows should be confirmed by

7.6.3 Define new data collection

This function allows the aquisition of up to 20 measurement values and store them
under a user defined name. This data can be processed afterwards by the
ChuckExplorer. This tool allows easy transfer of the data to a PC, showing it on xy
diagram and archive it. The number of stored data to be transferred to a PC is not
limited.

- First put in your individual entry. Navigate by using arrow
keys , confirm byn corrections to be made by ﬁ

or back.

iD:

Date: DD_MM_YY

iD: up to 10 characters/numbers

Number: Date: use format DayDay_MonthMonth_YearYear
(just use 2 last digits for year, e.g. 11 for 2011

Number:  maximum 3 digits, numbers only, range from
1to 254

A %t

Activate save or press the Speed Button floppy disk to memorize your entries. Now
you jump directly to measurement mode. Besides the measurement values the
number of stored measurements are indicated.

Use the arrow keys to navigate to the next entry.

Pressing Disc symbol in the Speed Button all entries are stored and a jump to
measurement mode follows. If window keep staying the same the cursor shows you
an invalid or not complete entry. Please check this line and try again.

If cursor keeps staying on the input mask after save or disk symbol is activated, the
Handheld Unit has recognized an entry error. Please check your entries regarding
this chapter again and use just valid characters.
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Speed Buttons layout for further actions:
Accept / overtake measured

000,0 «~
BB

value

Finish series of measurements
and exit to Set Menu

100

0000 +/min

Delete measured value

Charge Measuring Head (see
chapter 7.6.2.2)

&
(\

fo Handheld Unit always stores the last Measurement Head in use. If you switch on the
Handheld Unit after a while you do not have to activate the Measuring Head again.
The serial number will be stored inside the device till a new entry follows.

7.6.4  Settings

Following functions are available in this menu:

Contrast Allows quantitative changing of brightness by pressing
arrow keys left or right, confirmation by OK

= F Display Indication of measurement \_/alues.
1/min = force and number of revolutions or force only
1000 . .
Ibf Units Force unit to be changed from kN to Ibf and v.v.

Screen saver to be activated after x minutes when no
entries happens.

Time to be set from 1 bis 43 minutes, acceptance of
indicated value by pressing OK.

Reduces brightness to a minimum and helps to increase
operating time. When in Save mode the first entry leads to
normal indication again.

Screen
saver
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7.6.5 Menu Measuring Head

The Gripping Force Tester GFT®-X can operate with different Measuring Heads.
(@ Available are Measuring Heads for jaw chucks and collets. Furthermore, there is a
R choice of different clamping forces, dimensions and number of jaws available.

= Basically only one Measuring Head can communicate with

Handheld Unit at the same time. However this menu allows

administration of up to eight Measuring Heads. The

0001-1 0047-2 activated Measuring Head is marked with a triangle on the
left side of label.

The image on the left shows a Measuring Head with serial

no 0001-1 which is active.

To navigate use the arrow keys, confirm with n

@\ @\ @\ %

The following commands are available:

Choose Activates the relevant Measuring Head with the
Measuring Head triangle from the index

Add a (new) A sub menu will open and requires the entry of a new
Measuring Head Measuring Head serial number.

Delete

Measuring Head Deletes the Measuring Head marked

Recharge

Measuring Head see chapter 7.6.2.2
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7.6.6 Menu collet chuck

This menu refers to chuck jaw Measuring Head only, which serial number ends with
XXXx-3 or xxxx-4. The Measurement Head M3 and M4 offer the choice of 2 or 3
jaws.

The selection of the number of jaws is made with arrow
keys of the keypad. The active choice is indicated with a
white arrow.

For confirmation press n .

7.6.7 Select Language

11 The GFT®-X Handheld Unit is prepared for several languages:
Fahs

—
German English

Deutsch English

Italiano Espaniol I

Italian Spanish
Pycckumn - By
s

B i Russian Chinese

| I I Ifgl and I Japanese.

The selection is made with the arrow keys and confirmed by n .
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8 Measuring Head

There are four different Measuring Heads available for the GFT®-X. Two for collets (M1 and M2)
and two for chucks (M3 and M4)

The Measuring Head works according to the following principle:
Via a dedicated arrangement of strain gauges inside the Measuring Head, the mechanical
forces are converted into an electrical signal which is amplified by the integrated electronics,
transformed into a digital radio signal via a micro-controller and sent to the Handheld Unit.
There the data signal is encoded and displayed.

Factory provided the Measuring Heads are calibrated. After respectively 12 months
Infl@ SO

a check-up and a recalibration should take place by the manufacturer. The date for
9 the next calibration is shown under Menu Measurement or marked on the
=/ Measuring Head (see chapter 7.6.2.1).

Amma@ﬁ The maximum load is mentioned on each Measuring Head. Please make sure that
this value will not exceed because this can lead to non valid measurements or even
to the destruction of the Measuring Head.

Please be assured, that prior to measuring procedure the Measuring Head is tight
and plane-parallel clamped to the rotational axis.

8.1 Measuring Head M1 and M2 for collets

Via the 3 contact surfaces (support) on the Measuring Head the force is transmitted to the
measuring elements inside the housing. It is recommended to use special collets with smooth
finish in order to avoid damage to these contact surfaces. Furthermore, care must be taken to
insert the measuring head in such a way that it does not get tilted. The "jaw centre" inscription
must correspond to the centre of one of the three collet jaws. Please note, that compliance with
the above instructions will be decisive for the quality of the measuring values.

—
o]
=
-
[:h)
Q
i
&
=

support

Measuring head M1 (max. 75kN)
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support

Measuring Head M2 (max. 120kN)

8.2 Measuring Head M3 and M4 for jaw chuck

The Measuring Head M3 and M4 are provided for the measurement of tension or force in jaw
chucks. The Measuring Head M3 is designed for forces up to 90kN per jaw, the Measuring
Head M4 offers higher resolution up to a maximum clamping force of 15kN per jaw. Different
Extension Cylinders making the Measurement Head M3 and M4 applicable for nearly all kinds
of jaws. Extension Cylinders for minimum jaw diameter of 72, 88 and 108 mm are available by
default.

©)

F

2 and 3 jaws

< < S
[ToR = @
=
¢§§
y v ﬁ#"
F
3 jaws

(2407) I

2 jaws
(180%)

Measuring Head M3 (maximum load 90kN/jaw)
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©°)
F

2 and 3 jaws

54 mm
44 mm

=
w

'SAUTOBLOK .

¢

(

3 jaws

(240°) ]‘

F
2 jaws
(1807)

Measuring Head M4 (maximum load 15kN/jaw)

Figure:

Measuring head M4

with warning notice max. 45kN / 3 jaws)
(complies to 15kN / jaw)

By operating M3 or M4 following hints have to be considered:

Operation with 2-jaw chuck:

If operated with 15 or 25mm extension, the 8mm extension must always be
mounted to the unused jaws (at 120° und 240°)

Always fit the extension symmetrically (0° and 180°)

Always mount the Extension Cylinder firmly (screw the Torx screw down tightly)

Operation with 3-jaw chuck:
ma If operated with 15 or 25mm extension, the 8mm extension must always be

mounted to the unused jaws (180°)
Always fit the extension symmetrically (0°, 120° and 180°)

~—— Always mount the Extension Cylinder firmly (screw the Torx screw down tightly)

Inffo Only with original accessories correct measured values are ensured.
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8.2.1 Measuring Head Extension Cylinder for M3 und M4

The Measuring Head Extension Cylinder transmits the tension forces to a load cell located
inside the Measuring Head. For different chuck diameters Extension Cylinders are supplied
which can be easily exchanged to suit. A T15 Torx key is included for loosening and tightening
the screws.

The extension cylinders are to be used as follows:
Jaw chuck (Diameter in mm) 72mm 88mm 108mm
Extension Cylinders in mm 8mm 15mm 25mm

Assembly instructions see chapter 8.2.2

8.2.2 Mounting M3 und M4 Measuring Head

From the safety point of view and to prevent any injury, the Loading Bracket must be
used to put the Measuring Head M3 or M4 into the chuck.

Take the Loading Bracket like shown in the picture
and put the Measuring Head M3 or M4 into it.
After this, the Measuring Head can be insert into
the chuck until the Loading Bracket fit tightly in the
chuck. Now the chuck must be tensioned.

Because of that it is guaranteed, that the
Measuring Head is not tilt and it is in the optimum
measuring position.

Put the Measuring Head like shown into the
chuck.

Is the chuck tensioned, the Loading Bracket have
to be removed.

STOPR | Please be assured, that prior to measuring procedure the Measuring Head is tight
and plane-parallel clamped to the rotational axis and the Loading Brackets are
removed.
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8.3 Measuring procedere

Inflo Starting with the first measurement make sure that the Measuring Head is fully
charged. For this purpose the Measuring Head Power Jack is to be linked to the
9 Charge receptacle of the Measuring Head (switched off).

On/off switch Power-LED, twinkles when the Measuring Head is active
The unit will start operation by pressing the ON/OFF key for

about 2 seconds if the LED is blinking, the Measuring Head
is switched on.

DC power jack

Figure: Front cover Measuring Head

8.3.1  Static Measuring

For static measuring the Measuring Head is clamped and switched on. After the Handheld Unit
has been switched on, the immediate tension is recorded and indicated on the display.

8.3.2 Dynamic Measuring

Stand Magnetic base  After the Measuring Head has been

2 ) / clamped in a parallel plane (see
chapter 8.2.2) the stand with the
magnetic base must be fastened to
the support of the tool machine and
positioned in such a way that the
lateral  distance between the
Magnet for rpm measurement flattened end of the stand and the
Measuring Head is approximately 3

mm. The distance between the top

of the cover and the edge of the

flattened part of the stand should be

1-2 mm approximately. The stand

should end with the yellow cover of

the Measuring Head before the

Measuring Head M1.. M4 steel part begins.

When the Handheld Unit is switched on and rmp measuring is activated, the current gripping
force is determined and shown on the display. When the chuck is rotating at the same time, the
display shows besides the gripping force the corresponding actual number of revolutions
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Info If no data is displayed although the Handheld Unit is switched on and the
e measurement menu is activated, proceed according chapter 13 Trouble shooting /
FAQ's.

9 Calibration, Recalibration

The GFT®-X is carefully tested and calibrated on a test bench at the factory. A calibration
certificate is enclosed. This calibration certificate documents the traceability to national
standards, which realize the units of measurement according to the International System of
Units (SI).

The zero point of the Measuring Head could change due to stress (material fatigue) and due to
temperature variation. In a narrow range the measured value can be tared (set to zero) referring
7.6.2.1.

The GFT®-X is a calibrated measuring equipment, a recalibration should be performed by the
manufacturer after 12 months of operation. For calibration purpose we will ask you to send the
complete GFT®-X unit back to your supplier.

10 Maintenance, Service

The GFT®-X is a measuring device and should therefore be treated very carefully.

Infe Special care must be taken with respect to the Measuring Head extension with its

crowned surface. Due to the gripping forces, this surface might be subject to wear

e and tear in the course of time. A replacement is advisable at the latest when a ridge
becomes visible on the disk (spare part numbers see chapter 16)

If problems occur which cannot be solved as described in chapter 13, the complete GFT®-X
must be returned to the supplier. A detailed description of the problem will shorten the time to
repair and save costs.
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11  Measured data display / storage on PC

The GFT®-X is supplemented by the capable software module ChuckExplorer. This program
permits transfer of the data displayed and stored on the Handheld Unit to a PC / laptop. A USB
Connecting cable is included in the delivery package.

The gripping force and the corresponding number of revolutions can be graphically represented,
printed and stored on the PC. It is also possible to convert the measuring data into an Excel
spreadsheet and to store the graphical representation as bitmap. These data can then be used
for further processing in any program. This module represents an invaluable tool for
documentation, in particular with regard to a consistent quality management.

111 Installing ChuckExplorer

To operate the ChuckExplorer there is no need of detailed computer knowledge. The program
could be installed and runs under standard hardware. The function implemented are tested
under Windows XP and Windows 7.
To install the software please follow the instruction below:

» Switch on the computer and start Windows

» Insert Chuck Explorer disk in the CD-ROM drive

@ GFT-X 270 setup €D ... [T ][E1][%]

Install { Update USB-Driver ‘

Install ChuckExplorer ¥2,1 |

G F I -x Bedienungsanleitung |

Operating Insktruckion

|
2 7 o Version History ‘|
|

Online Update GFT-X

Homepage SCHURNE GmbH

Gripping Force Tester

scnunxf-j@

Exit |

The setup program starts automatically. If it doesn't you can also start the setup manually:
» Open the file manager / explorer
» Start the "AutoRun.exe " program on the ChuckExplorer CD-ROM
» First install USB-driver, then ChuckExplorer.

ChuckExplorer is now ready to be installed, the installation path can be freely chosen.

At the end of this process, a message confirms the successful installation and the program can
be started immediately.
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Startscreen ChuckExplorer (extract)

o — The menu bar is self-explanatory, i.e. a small info
Fie Edt GFTX Extras Help window will open when the mouse pointer is
: : ositioned on the individual button.

(&> BE P

D(_ascription of the individual push buttons:
Start a new measurement

Open a saved measurement

Save measurement

Download data from Handheld Unit

Delete internal memory of GFT®-X Handheld Unit (all measurement data will be
discarded)

File » New (|_|) open a new measurement series. The following screen will be shown:

m Command line
DexBAE D Button bar
b Lurkhled1]
e | Lk .
Tester | _..- st Speed Grrey e / Dlsplay (rpm /
I YT TR | = e = force)
[ dutomatic o 1/min F kN
|"‘l- P (i 1000 -
z™ < Diagram
g =]
E -:m:
PIE-I Spreadsheet
n ?I:fl dl'll'.l ’ t'i'lﬂ ' B0 |.r;'n
Speed [1/min] Handle for
window size

All program and menu windows can be changed in their size, by clicking on the right edge with
the mouse cursor.

H.-D. SCHUNK GMBH & CO. SPANNTECHNIK KG  Lothringer StraRe 23 D-88512 Mengen
Tel. +49-(0)-7572-7614-0 Fax +49-(0)-7572-7614-99 www.schunk.de



Gripping Force Tester GFT®-X 270 Rev. 1.8/1.5 12/2012 page 28

11.2 Using the software

Start ChuckExplorer by double click " % With the Command line all individual settings can be
performed.

% ChuckExplorer The desired language can also be selected by
Fie Edit GFT-x Command Extras » Language. Actually, German and

B A . F English versions are available.
— English
[ 1 | Tontitedi T+

# Settings
Chuck || Measurement
T 135943-2 )|
Tester [ Miller V' Stark
o
Date |30.11.2011 - Recard

- ;
*+romatic

Clear

£ Port selection Equally under Extras » Port the USB port to
ST irtual Serial Driver (COME) communicate with GFT®-X Handheld Unit
' - could be chosen.

Baudrate 115200 v

CF, ][ Cancel ]

M Poksetestien___ —— Just activate the button Auto scan. As soon
COMM port |Silicon Labs CP210: USE to UART Bridge (COMS) v/ [ amsean | | the Handheld Unit is found, the active port
Baudrate  |115200 v appears at the lower part of the window.

’ oK ] [ Cancel ]

GFT-% Found on port 'Silicon Labs CP210:x USE to UART Bridge (COMS)

¥ Settings
e With File » Setup following parameters can be adjusted:

- . Graphic: By pressing [ ) key a color bulletin appears. Choose
— 1 =) the color you want for the diagram and its background.

Background |

Autamatic messurement Automatic measurement (Automatic mode):

© percental O fixed o The criteria to take over a measure automatically is the revolving
Tolerance [%] £ |5 ~ Speed.

Tolerance [1jmin] |51 | | Setting Percentaged:

Hold tine [5] ' ' The sample shown left means the speed should be within less than

+/-5% of the maximal speed and should be there for at least 3

Chuck | Callet
seconds.

Setting Fixed:
Tester If the speed is x £50 [1/min] during the hold time, the measured
value is taken over.

[ Ok ] [ Cancel ]

Automatic measurement settings:
» Tolerance [%] *+ 1-10%,
» Tolerance [1/min] — freely selectable
» Hold time [s] 1-5sec (0,5sec steps)
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2 Edit chuck / collet

Equally different chuck / collets and Tester can be saved
in the settings.

54|
1 <reservedz 2} Hlew

2 135948-2 | | Delete

The first line is reserved by the system.

At the click of a mouse into the field the entries can be
edited. New adds a new entry, Delete erases an entry which
is required no more.

3 |

QK

£ Edit tester These entries are available in the main window now at

Chuck or Tester and can be called up over the arrow button

().

1 <reserved: i

2| Miller | [ Dslete

3 gMcIntosh |

OK

I B
X

Under Help, you will find information about the current software version as well as
comprehensive explanations concerning the individual software functions (F1) and the terms

used.

s GFT-X » Load data: Data to be downloaded from a series
S LSy isl of Handheld Unit measures into ChuckExplorer (see also

Fle Edt [ Extras  Help chapter 7.6.3).

] E i Load data. .. Chrl+L
by sserchasi: __SEie) "rwea; GFT-X » Delete data: Allows remote deleting of Handheld
= Unit memory, it is recommended to do so after every
¥ " download to assure having sufficient memory space for next

measurement available.

48 ChuckExplorer Edit » Copy table: To copy the table into the clipboard. The
GFTX  Extras  Help spreadsheet can be dropped easily in Excel or a Word processing

Copytsble | [ program for further processing.
4 Copy chart o

Edit » Copy chart: To copy the displayed diagram into clipboard and
could imported or paste in Bitmap-Format into other programs.
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11.2.1 Measurement

There is a general distinction between two different methods for storing the measured values
with the GFT®X Handheld Unit (see chapter 7.6.3 and 11.3) and directly with the
ChuckExplorer.

If the measured value recording is made directly by the ChuckExplorer, then there is the
possibility of a manual and automatic measured value recording.

¥ ChuckExpl .
In case of manual storing of the measured values, the

Fil Edit  GFT-%  Ext Hel . .

e e user can decide by himself at what rpm value or at what
L] = E force he wants to store a value.

When automatic storing is activated, two new input lines

Lureiedt] are provided. Here the maximum number of revolutions
A ¥ Measurem - (IMax speed) and the number of steps are defined, the
Tester v [ st Program divides the maximum number of revolutions by
Bt PR 3 - the number of the measured values to be stored and
i ~ logs them as soon as the relevant numbers of
i Mk 1”;;; revolutions are reached (see chapter 11.2.4).
Steps 20 |

speed  Gripping force
. [kN] [%e]

800

N~

' [kN]

11.2.2 Measurement preparations

Relevant data and parameters can be entered into the program and included into the
measurement log so that a measurement can be documented.

Machine or chuck ID and the name of the Tester are entered on the left side in the upper part of
the program window. Up to 10 names are stored by the program and are available for future
measurements. They can be displayed and selected by clicking on the = button beside the text
field.

The Daté field is feeded directly from

=2 - = the system, however it can be
LE&BE changed in the same way. This is

[untitedi T+ ' necessary e.g. if measuring
sequences stored on the Handheld
Unit are read out only after several

Chuck.

13535 | | Information
3Jaws 13533-2 v . Measurement

Tester Millet| ~|

| | days (see chapter 11.3).
[rate 01122011 » weight | Sat I .[kg] y ( p )
[ automatic e : : .y .
ol oer || o e - After clicking on the Information tab,
| MO, 7 -
p—lftdmml) D] - P you can enter further parameters (jaw
adius of Gravity ) .
it i type, hydraulic pressure, etc.) in the
' right-hand part of the display window.
L [ 'mm  These parameters are recorded
w mm1  together with the measurement.
H | :[mm]

Pressure | [bar]

Force [ [kr]
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11.2.3 Manual measuring
For starting the measurement, the Measurement tab must be active and the Start button must

. _ . be pressed.
Wemeaonent | | — The button Start changes to Stop, number of
el R revolutions and gripping force will be indicated.

-_Record 0 1[ o 0 . 0 ki

Clear

By each click on the Record button, a measured value is stored and displayed in the
spreadsheet on the left and in the diagram. The scale of the chart is switched to the optimum
range in order to get a better optical presentation.

If a measuring sequence is complete, it can be stored on hard disk Stop, File » Save.

£ ChuckExplorer EHE'@
Detsi Bearbeiten GFT-%  Extras  Hife
= o
L& g E
Test_L.gft
Spannfutter %
ey 135332 ~|| Messen Informatian
ey vy = Drehashl Spanniraft
Datum 29.11.2011 & 0 0 0
Ackomatik 1/min % kN
Léschen
Drehzahl  Spannkraft =
Nr. [1/min] Tin] [%] 240 ]
0 3000 2400 100 S
1 3500 2300 95.8 =
z
= 220 o
2 4000 2200 9L6 =
=
3 4500 2100 87.5 D210
=
4 5000 2000 833 =
& 200 4
5 5500 195.0 813 W
6 6000 190.0 79.2 i
7 65l 185.0
T T T T T T 1
8 650 183. 3.500 4.000 4.500 5.000 5.500 6.000 6.500
Drehzahl [1/min]

force’ / “Gripping force in percent from
and rotational speed reference value (measure number 0)

11.2.4 Automatic measuring

If chepk box Automatic M is activated, two new input fields
_ are displayed. Here you can enter the maximum number
File Edit @FT-X Extras Help .

= = of revolutions (Max speed) and the number of
e 2 E measurement steps. The software will then determine
funtitled] automatically the equidistant numbers of revolutions

o o ——— (1/min) for which the measured value is to be stored.

3-laws
o = [ st The rpm tolerance and the minimum time during which the
Bee 01.12.2011 4 recor FPM vValue must be constant within the tolerance range can
O _ s D€ setin menu item Setup (see chapter 11.2).

Maxspeed 5000 [1/min] 1o The measurement is started by the Start button. If the
Steps 20 | maximum number of revolutions is reached, the program

o Will automatically terminate the measurement and display
the corresponding table of values and the graphical
evaluation.

e Speed  Gripping force
= [kN]

[%]

» [kN]
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11.3 Download data from GFT®-X Handheld Unit

Measurements recorded by a series of measurements (chapter 7.5.3) and saved in the internal
memory of the GFT®-X Handheld Unit, can be downloaded directly from the Handheld Unit with
GFT-X » Download and afterwards indicated. If several IDs and / or series of measurements
transferred, they are shown as different tabs.

A backup of data of the indicated series of measurements is necessary before. Choose
therefore File » Save... or Save as.

After download and the backup of data on the PC, data memory of GFT®-X Handheld Unit can
be deleted completely with GFT-X » Delete memory.

11.4 Loading and saving files

Choose File » Save to save your recorded data. The directory is user-defined, files end with
* gft. Will be several series of measurements (Files) downloaded from GFT®-X Handheld Unit,
the active tab will be saved.

AChtUNG| Do not store the measuring data in the program directory of the ChuckExplorer or in
A a subdirectory of it. If ChuckExplorer will be uninstalled, these data files are erased,
too

Choose File » Open to open an existing data file. The filename appears in the tab bar.

-] ChuckExplorer

File Edit GFT-¥ Extras Help
= o
ABZ011_1,gft* BBII_L.qft

Chuck
F-Jaws

Taster Miller v Speed Gripping Force

Afz011 “w|| Measurement | Information |
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12  Software update

The software of the GFT®-X handheld unit is improved constantly and is subject to certain

changes. The actual software version will

be displayed in the Welcome Logo. Starting with

version 1.2 online update is possible, older versions need to be updated at the manufacturer.

To start the update please follow the instruction below:
» Switch on the computer and start Windows
» Check if your computer is connected to the Internet

» Close the chuck Explorer Software
»

T GFT-X270 Setup CD V3.3

=i

Install / Update USB-Driver

Install ChuckExplorer v2.1

GFT-X
270

Bedienungsanleitung

Version History

Online Update GFT-X

Qperating Instruction |

Homepage SCHUMK GmbH

Gripping Force Tester

scuunxf-j@

Insert Chuck Explorer disk in the CD-ROM drive

The setup program starts automatically. If not you
can also start the setup manually:
» Open the file manager / explorer
» Start the "AutoRun.exe " program on the
ChuckExplorer CD-ROM

Choose Online Update GFT-X and perform the
instructions step by step, otherwise the update
could fail.

7| GFT-X web updater
?

The online update starts in a separate

Ready for online update!
The procedure requires about 20 minutes.

GFT-X
270

Gripping Force Tester

sa-lum(f-j“

[ Update GFT-X ]

window. At the right side, the state of the
update is shown.

A bar chart that shows the progress of
each step of the program is located at the
bottom of the window.

It will take 20 minutes to update the
Handheld Unit.

Please make sure, your GFT®-X Handheld
Unit is connected via USB to your
computer and switched on.

0%

The update starts by pressing the Update GFT-X button.

5| Update GFT-X

the computer via USB before you start the update.
Faollow the instruction of the process.

The device will be switched off automatically during the
update.

(5]

Be shure the GFT-X device is switched on and connected with

Do not disconnect the USB connection during
the update, otherwise a factory service will be
necessary.
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7| GFT-X web updater
?

Now the update program is connected with

Ready for online update!

The procedure requires about 20 minutes.
Searching GFT-X....

GFT-X found on port |\, {COM10

Chedk online update availability...

Server information found. Update available.
Download update files...

GFT-X
270

Gripping Force Tester
SCHUNK &5

Update GFT-X

GFTX_1_5_0.mhx

the Handheld Unit.

Available software updates are to be
download from the Internet and saved
temporarily.

| 78%

(% J[mesm]
Switch on the device with a short press on the ON/OFF
Buiton to start the software update process.

This dialog will be closed automatically when the
software update process staris.

If you press Abort the whole update progress is

stopped.

7| Handheld unit software update

A short press on the ON / OFF Button starts the
update procedere.

Switch on the device by pressing the ON/OFF Button
until the screen is illuminated. The upload starts
automatically.

This dialog will be closed automatically when the
image update progress starts.

If you press the abort-button the update progress will
canceled.

1 GFT-X web updater l=l= ==l First the Handheld Unit firmware will be
‘ updated.
Ready for online update!
The procedure requires about 20 minutes.
SEar-mEEnGd:rjaErt W \coM10 H : R
GFT—X ek ot i During this process do not interrupt thg
Upcating Handheld Uni. .. USB connection between Handheld Unit
270 and Computer.
Should that happen, please send the
Gripping Force Tester device with a corresponding note to the
service center.
sa-lum(g“
Update GFT-X
Updating Handheld Unit firmware
| — ] | s3%
71 Image update [ 2 = | Now, the graphic files will be transferred to the

Handheld Unit.

Should the USB connection be interrupted during
this process, start the update once again.

The update of the graphics files will take about 15
minutes.
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=5
.;6;. Handheld Unit updated successfully

% | Updating GFT-X

S
12.1

[l

5 | Search GFT-X

Iﬁﬂﬁ' Mo Handheld Unit found.

Be sure the device is connected via USB
and switched onl

Then start the update process again.

5 Close apphcation

The application cannot be closed before the current
operation has finished!

This message appears after successful update.

After pressing the OK button, the unit can be used
for measurement again.

It is advisable to check periodically your suppliers website for updates.

Problems with the Update of the GFT-X Handheld Unit cause / corrective

This error can be caused by different causes:

»

»

Check, whether the Handheld Unit is
switched on
Check, whether the Handheld Unit is

correctly connected to computer via USB
Check whether another USB device with
same chipset may blocks the connection
check whether the USB driver has been
installed correctly, if necessary, install it
from the ChuckExplorer CD-ROM

check that the Chuck Explorer program is
closed.

Data is sent from the computer to the Handheld
Unit, the programm cannot be closed. Please wait
until the update is finished.

2| Updating GFT-X 5] please repeat the update process. If the update
i Error while uploading images to the flash | fails again so please send the device with a
x corresponding error description to the service
center.
2 == This message appears if the user correctly cancels the update
i Update canceled | operation. This is no fault notice.
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13  Trouble shooting / FAQ’s

13.1 Problems at GFT®-X Handheld Unit cause / corrective

Display will not be illuminated / start after pressing the power button
» Check power supply, recharge Handheld Unit battery
» Press power button again (not less than 2 sec.) until blue LED indicator begins to flash
» Connect Handheld Unit via USB-cable to mains adapter or PC, try again

Keypad is not responding to keystrokes
» Switch off Handheld Unit, wait approx. 5 seconds, then turn power on again

Icon radio communications in Status Line is / keeps staying red
» White LED indicator at Measuring Head front face must flash, if not try to recharge
Measuring Head battery
Radio interferences, e.g through shielding or (metal) absorption, relocate
» Wrong Measuring Head selected / activate appropriate serial number again

Tare-icon in status bar is red
» Offset of the Measuring Head is too high, tare is not possible any more. Measuring Head
has to recalibrated by the vendor

During the measurement dashes appear in the display of the Handheld Unit
» Battery in Measuring Head empty / discharged
» Radio interferences

Blue LED indicator at Handheld Unit is flashing
» Screen saver is active, press any key to continue (except ON/OFF-key)

How to allocate the Speed Buttons
» Select desired function, then press Speed Button until icon appears in the Speed Button
bar.
» Selected Speed Button function can not be deleted, only overwrite possible

Right Speed Button can not allocated to other functions

» Right Speed Button reserved for function "Charge Battery" only.

13.2 Problems with Chuck Explorer — cause / corrective

Data download not possible

P —— » No connection from GFT®-X Handheld Unit to PC, check
o ) USB-interface cable
@ RS e » Check interface settings in ChuckExplorer: is COM Port
selected?

» Check whether the Handheld Unit is switches on
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After pressing the start-button an error message appears

£ Onli ) ) : )
Ll . » Check if proper Measuring Head is activated
_[X SRE Dbt » Check power of Measuring Head — white LED
indicator must flash
» Check whether the Handheld Unit is switches
on

& Online » Check interface settings in ChuckExplorer: is
' COM Port selected?

'\_. Mo measure head connected, Online mode is not started.
L3

Port Selection - Auto Scan
» Reboot ChuckExplorer, then choose
Extras » Port » Auto Scan

*r,‘,’ Auto scan

\y Mo port Found with a GFT-# connected. Check connection to GFT-X device! } CheCk Whether the Handheld U nlt |S
switches on

» No connection from GFT®-X Handheld
Unit to PC, check USB-interface cable

Speed (rpm) will not displayed in online-mode
» Due to the Refresh-Rate the Speed of rotation rpm it could happen during machine
stillstand. However when late is turning again the indication should appear properly.

Error when starting a new measurement

4% Device communication » choose Extras » Port » Auto Scan
@ Part could not be opened, Check if the device is connected? > NO ConneCtiOI’l from GFT®'X Handheld Un|t
to PC, check USB-interface cable

Error message: "During the first measurement gripping force must be above zero"

§% Record data » To afford a calculation of the percentage
g\ Messure vae must be grester than 0.0 aberration, the first measured gripping force must
) be above zero.

This value will not be stored.
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14  How to change the power plug at mains adapter

The GFT®-X Handheld Unit is powered with a Power Supply Plug at 5VDC (500mA), the input
voltage range is 100~240V.

Different interchangeable blade assemblies of North America, United Kingdom, Australia and
Europe are included. The blade assembly of Europe is already mounted.

Insert the blade assembly (as shown in following figures):

» Hold the power supply in one hand using thumb or finger, slide the spring loaded locking
key downwards (it is marked with an arrow, Picture 1).

» Hold the locking pin down pull upward on the blade to remove (Picture 2).
X

Picture 1 Picture 2

» Insert now the required blade assembly:

‘-‘mn.‘. g .t-\.
Picture 3 Picture 4 Picture 5 Picture 6

» Insert the tip of the blade assembly into the power supply at a 30 — 60 degree angle
(Picture 3). The top edge of the blade assembly is flat and the bottom edge is U-shaped.
The power supply has the corresponding shapes.

Push the blade assembly into the power supply in a downward motion (Picture 4)

» Push the blade assembly down until the blade assembly locks in place. A clicking sound
will occur (Picture 5).

» Checking the blade assembly for correct insertion: Hold the power supply in one hand.
Using another hand pull up on the blade (Picture 6).

Info Note: The blade assembly is "finger proof"' which meets UL requirements against all

Q shock hazards.

H.-D. SCHUNK GMBH & CO. SPANNTECHNIK KG Lothringer StraRe 23 D-88512 Mengen
Tel. +49-(0)-7572-7614-0 Fax +49-(0)-7572-7614-99 www.schunk.de



Gripping Force Tester GFT®-X 270 Rev. 1.8/1.5 12/2012 page 39

15 Changing the battery of the Handheld Unit

Furthermore GFT-X is equipped with a
powerful Lithium-lon battery. A one time
charge allows an operation up to 5 hours.
During this time frame, a Measuring Head
can be loaded up to 4 times out of the
Handheld Unit battery.

Info Technical Data:

Li-lon rechargeable battery,
e 1950mAh, 3.7V

Safety Instructions:
» do not incinerate
» do not disassemble
» do not short terminals
» do not expose to high
temperature

For replacement of the Li-lon battery open the battery box
on the back side of the GFT®-X handheld unit. For this
purpose, please use a suitable screwdriver or a 20 cent
coin

Remove the battery carefully and separate the plug
connector. Therefore press the latch battery-sided
downwards and separate plug and socket (see yellow
pictograph).

Connect the new battery with the plug inside the GFT®-X
Handheld Unit. Insert the battery as shown beside into the
housing and close the battery cover carefully.

Recharge the battery before first use completely.
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16  Accessories / spare parts list
Item Id. Bezeichnung
203819 GFT®-X complete incl. case, Measuring Head M3 and Handheld Unit
1 - GFT®-X case (case only)
2 204003 GFT®-X Handheld Unit
3 204004 GFT or GFT®-X Measuring Head M1 (optional)
4 204005 GFT or GFT®-X Measuring Head M2 (optional)
5 204006 GFT or GFT®-X Measuring Head M3 (standard)
204007 GFT®-X Measuring Head M4
204008 CD with ChuckExplorer and operating instructions
6 201764 Power Supply Plug USB incl. interchangeable blade assemblies
7 196839N Loading Bracket for GFT or GFT®-X
8 198161 Recharging cable for GFT or GFT®-X, 1m, Push-Pull
9 201765 USB-cable for GFT®-X, 1.5m
10 036201 Extension Cylinders 8mm for GFT or GFT®-X
11 036203 Extension Cylinders 15mm for GFT or GFT®-X
12 036205 Extension Cylinders 25mm for GFT or GFT®-X
13 201766 Stand with magnetic mounting for GFT or GFT®-X
085961 Torx-key for GFT or GFT®-X M3 and M4
033010 Spare screws
201922 Protector for GFT®-X Handheld Unit
201923 Spare battery for GFT®-X Handheld Unit

Prices and delivery times on request! Please contact your local vendor.
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